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Cell Design Tutorial

1
Getting Started with the Cadence
Software

In this chapter, you learn about the Cadence® software environment and the
Virtuoso® layout editor as you do the following tasks:

■ Copying the Tutorial Database on page 1-3

■ Starting the Cadence Software on page 1-5

■ Opening Designs on page 1-10

■ Displaying the mux2 Layout on page 1-15

■ Setting Layer Visibility on page 1-17

■ Measuring Distances on page 1-18

■ Changing to a Previous Zoom or Pan Image on page 1-22

■ Using Help on page 1-26

■ Using the Help Button on page 1-27

■ Exiting the Cadence Software on page 1-28

When you finish this chapter, you will be able to

■ Start and exit the Cadence software
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■ Display and browse the tutorial libraries

■ Open a library and a layout window

■ Use the Layer Selection Window to set layer visibility

■ Measure shapes in a layout window

■ Pan, zoom, and scroll in a layout window

■ Go back to an area you viewed previously

■ Access online Help

■ Quit the layout editor

Prerequisites
Before you begin the tutorial, be sure your system administrator has installed
the layout editor and (optionally) the Assura™ interactive verification products.

Here are some questions to ask your system administrator:

■ Where is the tutorial directory?

■ What command do I use to start the Cadence software?

The command for starting the Cadence software varies depending on the
software options your company purchased.
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Copying the Tutorial Database
You need to copy the tutorial database, which is located under your Cadence
installation directory, to your home directory. The following steps copy the
tutorial database directory called cell_design under your home directory.

This tutorial does not use or cover the Team Design Manager (TDM). For
information about TDM, refer to the Team Design Manager User Guide.

The steps in this section assume

■ Your environment is already set up to run Cadence software

■ You are logged in to your account

■ You will copy the tutorial database directory into a non-TDM area

1. Be sure you do not already have a directory named cell_design in your
home directory by typing

cd ~
ls cell_design

If the response is cell_design: No such file or directory,
continue to step 2.

If the response is a list of files, you have a cell_design directory. You can
copy the latest cell_design directory to your home directory after you
rename the cell_design directory in your home by using the following
syntax.

mv cell_design old_cell_design
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2. Find the installation directory for Cadence software by typing

instdir

You see the installation directory; for example,

/usr/cadence/tools/dfII

3. Change directory to your_install_dir/samples/tutorials/le.

For example, if your installation directory is

/usr/cadence/tools/dfII

type

cd /usr/cadence/tools/dfII/samples/tutorials/le

4. Copy the cell_design directory to your home directory by typing

cp -r cell_design ~/

The cell_design directory should contain these files and subdirectories:

.cdsenv

.cdsinit
ROD
cds.lib
cellTechLib/
display.drf
master/
mux2_strmin.template
mux2_strmout.template
pCells/
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skill
tutorial/

If the data was not copied successfully (you get an error message), type

cd
rm -rf cell_design

and try copying the cell_design directory to your home directory again.

Starting the Cadence Software
The rest of this chapter will take you through some basic tasks using the
Cadence software and the Virtuoso layout editor.

This section tells you how to

■ Start the Cadence software, including changing to the tutorial working
directory and finding the executable filename

■ Use the Command Interpreter Window (CIW), which is the main control
window for the Cadence software

■ Use menus and forms

Setting the Working Directory

The working directory is where you start the Cadence software. Your Cadence
initialization file, .cdsinit, contains commands and default settings for this
tutorial. Any files or libraries you create during your editing session are stored in
this directory, unless you specify otherwise.
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To set the working directory,

➤ Change to the tutorial database directory by typing

cd cell_design

The cell_design directory is your working directory for this tutorial. All
paths in this tutorial start in this directory.

Finding the Executable

To start the Cadence software, you need to know the executable. If you do not
know the executable, you can search for it. If you already know the executable
filename, you can skip this section.

The layout editor executables are layout (layout and interactive design rule
checking) and layoutPlus (layout, complete verification, and other layout-
related tools such as compaction). To do all the exercises in this tutorial, you
need to have layoutPlus. If you have only layout, you will not be able to do
some of the verification steps in this tutorial.

To find the executable,

➤ At the UNIX prompt, type

which layoutPlus

If layoutPlus exists and your search path is set correctly, you see a
response similar to

your_install_dir/tools/dfII/bin/layoutPlus
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your_install_dir is where the Cadence software is installed. You
might want to make a note of its location for future reference.

If you see a response that looks like

no layoutPlus in . /usr/bin/X11
/usr/local /usr/ucb /bin /usr/bin /usr/hosts

either you do not have layoutPlus or your UNIX search path is not set
correctly. Ask your system administrator for help.

Loading the Cadence Software

Once you are in the correct working directory (cell_design), you can start the
Cadence software. The following step shows how to run the software as a
background process so that your xterm window is still available to do other tasks
while the Cadence software is running.

To load the Cadence software,

➤ Type

layoutPlus &

The software might take a few minutes to load. You see a series of
messages in your xterm window about the process number and the
Cadence products being started. The CIW appears and the following
message scrolls into the window:

Done with initialization.
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You can exit the Cadence software at any time, no matter where you are in
your work. To exit the software, see “Exiting the Cadence Software” on
page 1-28.

Using the CIW

The CIW is the control window for the Cadence software. The following figure
shows the parts of the CIW.

Window title displays the Cadence executable name and the path to the log
file that records your current editing session. The log file appears in your home
directory.

Menu banner lets you display command menus to access all the Cadence
design frameworkII tools.

Output area displays a running history of the commands you execute and their
results. For example, it displays a status message when you open a library. The
area enlarges when you enlarge the CIW vertically.

Menu banner

Window title

Output area

Input line

Mouse bindings
line

Prompt line
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Input line is where you type in Cadence SKILL language expressions or type
numeric values for commands instead of clicking on points.

Mouse bindings line displays the current mouse button settings. These
settings change as you move the mouse in and out of windows and start and
stop commands.

Prompt line reminds you of the next step during a command.

Using Menus and Forms

Most of the menus you use in the Cadence software are pull-down menus. Pull-
down menus appear at the top of a window. You click a menu title to pull down
the menu and see the commands listed on it. The pull-down menus are the
primary place to find commands.

Many commands have forms you use to supply the command with additional
information. Some commands have option forms that you do not always need.
You can use the User Preferences command to set whether or not option
forms always appear when commands start. In this tutorial, option forms always
appear when you start commands.

To see how the pull-down menus work,

1. In the CIW, click Options.

You see the commands on the Options menu. Notice the three dots (...)
following the commands. These dots mean a form appears after you click
the command.
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2. Click anywhere outside the Options menu to close it without starting a
command.

If you accidentally choose a command, click Cancel in whatever form
appears to cancel the command.

3. Click Options again.

4. Click User Preferences.

The User Preferences form appears. This form contains settings that
control how the Cadence software behaves. It was set for you in the
tutorial .cdsinit startup file.

5. Click Cancel in the form.

Canceling the command ensures that you do not change the user settings.
If you click Apply or OK, the user settings change to whatever is in the form
at that time.

Opening Designs
The Open File form lets you open designs in the libraries.

In this section, you learn

■ How to open the Library Browser window

■ About the tutorial libraries

■ How to look at the contents of the master library
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The master library contains the complete multiplexer design you will create in
the following chapters of this tutorial.

Opening the Library Browser

To open the Library Browser,

1. In the CIW, choose File – Open.

The Open File form appears.

2. Click Browse to browse the libraries.

The Library Browser – Open File form appears.

The tutorial cds.lib file gives you access to all the tutorial libraries. The
next section describes these libraries. Depending on the software
purchased by your company, your form might show some additional
libraries.

Though you can browse and select libraries, cells, and views in the Library
Browser window, you must open the selected cellview from the Open File
form.
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3. View the contents for the master library by clicking master in the Library
column.
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About the Tutorial Libraries

The libraries contain the following information:

basic Reference library supplied with the software. Contains
basic symbols, including ground, power, and input and
output pins.

cdsDefTechLib The default technology library supplied with the
software. Contains the default technology file.

cellTechLib Technology library for this tutorial. Contains the
technology file, symbolic devices, and rules used by all
the other tutorial libraries.

master Design library supplied with this tutorial. Contains the
completed designs for the tutorial.

pCells Reference library supplied with this tutorial. Contains a
collection of pcells.

ROD Reference library supplied with this tutorial. Contains
ROD instances.

sample Reference library supplied with the software. Contains a
sample collection of gates and cells.

tutorial Design library supplied with this tutorial. You use it to
store your designs as you follow the steps in the rest of
this tutorial.
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Browsing the Master Library

This section lets you explore the tutorial design by displaying the contents of the
master library. The designs are called cells. A cell represents a particular
function of a larger design. For example, one of the cells in the master library
represents an inverter design (Inv), one represents a nand2 design (nand2),
and another represents the multiplexer layout (mux2) that contains the inverter
and the nand2.

Each cell can have multiple views called cellviews. A cellview is a specific
representation of a cell; for example, a layout or a schematic.

➤ In the Cell column, click mux2 to display the cellviews for the mux2
design.

The view names appear.

The mux2 cell has six cellviews.The cellviews and their uses are described
here:

❑ The abstract cellview contains an abstract representation of the
layout for use by Cadence placement and routing software.

❑ The extracted cellview contains layout with connectivity for use by
verification programs.

❑ The layout cellview contains a traditional layout using polygons and
other shapes.

❑ The layout_save cellview is a backup of the layout cellview.

❑ The schematic cellview contains the logical design for the
multiplexer.
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❑ The symbol cellview contains a symbol representation of the
schematic.

Displaying the mux2 Layout
In this section, you learn to open the layout for the multiplexer design (mux2) in
read-only mode. This prevents you from making any changes in the master
library.

1. In the View columnn of the Library Browser window, click layout.

2. In the Library Browser window, click Close.

The Library Name, Cell Name, and View Name fields in the Open File
form display the information you set in the Library Browser window.
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3. In the Open File form, click the read radio button to display this cellview in
read-only mode.

4. Click OK.

The layout window opens and the multiplexer layout appears. The window
has several components: icon menu, menu banner, and status banner.

The icon menu appears (by default) on the side of the window, listing the
icons for frequently used commands. The menu banner contains menus
that let you execute the layout editor commands. The status banner
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displays mode and coordinate information. Each component is explained
in detail in later sections of this tutorial.

Another window, called the Layer Selection Window (LSW), appears.

5. To see the commands that you can use from the icon menu, slide the
mouse over the icons.

As you move over an icon, the command name appears.

Note: When you open a cellview in edit mode, more icons appear in the menu.

Setting Layer Visibility
The Layer Selection Window (LSW) lets you

■ Choose the layer on which you create objects (called the entry layer)

■ Set which layers are selectable

■ Set layer visibility

There are several ways to change the LSW to make layers selectable, visible,
and valid. In this section, you learn to use the LSW to change the visible layers
in the mux2 window.

To see how layer visibility works,

1. Make the text dg layer not visible, by moving the cursor over the text
dg layer in the LSW and clicking middle.

The middle mouse button toggles layer visibility. It also automatically sets
invisible layers to be unselectable.
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The text layer color disappears to show the layer is invisible. The layer
name turns gray to show the layer is not selectable.

Note: If you click the text dg layer and then click middle, an error message
appears saying you cannot set the entry layer to be invisible. To correct this,
click a different layer in the LSW, and then click middle again on the text
dg layer.

2. In the mux2 window, choose Window – Redraw.

The mux2 layout is displayed without labels because labels are created on
the text layer.

3. In the LSW, click the AV (All Visible) button.

The colored squares showing the layer color reappear, and the shading on
the layer name disappears.

4. In the mux2 window, choose Window – Redraw.

The mux2 layout is redisplayed with labels.

You must redraw the window to see the effect of LSW changes, so you can
make several changes before you take the time to redraw a complex
design.

Measuring Distances
Most designers must create objects according to precise measurements. The
layout editor provides functionality to help designers be as precise as possible.
In this section, you learn to
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■ Enlarge (zoom in) a portion of the cellview

■ Create a ruler to measure objects in the cellview

Zooming In on the Multiplexer Design

You can zoom in on the layout to see details. This makes it easier to measure
small shapes. You zoom in by creating a box around the area you want to
enlarge.

Note: Zooming in does not enlarge objects in the database. It enlarges only
what you see.

To see how zoom works,

1. In the mux2 window, choose Window – Zoom – In.

A prompt in the CIW tells you to create a box around the area you want to
enlarge.

To see the details of one of the n-type transistors in the mux2 layout, you
can create a box around the area.

2. Click one corner of the box, then click the opposite corner of the box, as
shown in the figure.
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The area enclosed by the box is enlarged to fill the window.

Measuring Distances with the Ruler

Now you use a ruler to measure the gate length of the transistor.

1. In the mux2 window, choose Window – Create Ruler.

The Create Ruler form appears.

2. Click one edge of the poly1 layer.
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A ruler appears and grows as you move the cursor. The current length of
the ruler appears at the end of the ruler.

The ruler measures objects in user units. Your system administrator
defines the units in a file called the technology file. User units for this tutorial
database are set to microns, which are also the default setting for the
Cadence software.

3. Look at the status banner to see the coordinate display.

The status banner always shows the following information whenever you
create any object:

❑ X and Y show the current cursor coordinates.

❑ Dist (distance) shows the distance between the last point you entered
and the current location of the cursor.

❑ dX (delta in the X direction) and dY (delta in the Y direction) show the
difference between the last point you entered and the location of the
cursor.
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You can also use the coordinate display in the status banner to measure
the distance between points you enter.

4. Click the opposite edge of the poly1 layer to complete the ruler.

5. In the Create Ruler form, click Cancel to stop the command.

All layout editor Create commands, such as Create Ruler, automatically
repeat until you cancel them or start a different Create command.

6. Choose Window – Clear All Rulers to remove the ruler you drew.

The ruler disappears. These rulers are not part of the cellview and are not
saved. The Clear Rulers command removes all rulers in the cellview.

Changing to a Previous Zoom or Pan Image
The part of a design you see displayed in the window is called an image. While
you go through this tutorial, you might need to alter the image to see the design

Cursor coordinates
Distance between the last
point entered and the
cursor location

Difference between the last coordinates
entered and the current coordinates

X: 10.5 Y:17.5 (F) Select:0 dX: 1.0 dY: 0.0 Dist:1.00
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more clearly. In the next sections, you learn how to alter the image, including
how to

■ Fit the entire design into a window

■ Return to the previous image

■ Reduce the amount of detail you see (zoom out)

■ Use the window scroll bars

■ Use the mouse to zoom in and out

You also learn to use a bindkey, which is a shortcut to start commands. This
tutorial periodically points out the bindkeys to start commands.

Fitting a Design in a Window

To see the entire design,

➤ Choose Window – Fit All.

The entire mux2 design is displayed in the window.

You can use Fit All any time you want to return to the full view of a design.

Returning to the Previous Image

The layout editor automatically keeps up to three images in memory. You can
easily return to a previous image.

To see the previous view,
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➤ Choose Window – Utilities – Previous View.

You see the area you zoomed in on earlier.

Using Window Scroll Bars

You can also use the window scroll bars to change the image.

1. Place the cursor on the scroll bar at the bottom of the window.

2. Click and hold, then move the scroll bar to the right.

The contents of the window scroll to the bottom right section of the design.

3. Place the cursor on the scroll bar at the right of the window.

4. Click and hold, then move the scroll bar up.

The contents of the window scroll to the top right section of the design.

Zooming Out

To zoom out,

➤ Choose Window – Zoom – Out by 2.

The window now shows more of the design at a smaller magnification.

Using the Fit All Bindkey

You can start most of the layout editor menu commands by using one or two
keys on your keyboard, called bindkeys. Using the bindkey is the quickest way
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to start a command. You can find out the bindkey for a layout editor command
by looking to the right of the command on the menu.

1. Click the Window menu and look at the characters to the right of the
command names.

These characters are the bindkeys for the commands. A lowercase letter
means you press just that key; an uppercase letter means you hold down
the Shift key and then press the key. A caret (^) means you press the
Control key while pressing the letter key.

2. Close the Window menu by clicking in an empty part of the design.

3. Press the f key to execute the Fit All command.

The f key is bound to the Fit All command. You see the entire mux2
design again.

Remember to look at the bindkey equivalent when you use a pull-down
menu so you learn bindkeys for future use.

Zooming In and Out with the Mouse

Instead of choosing the Zoom – In or Zoom – Out by 2 command, you can
use the right mouse button to zoom.

To zoom in,

1. Click and hold right on one corner of the area you want to enlarge.

2. While still pressing right, move the cursor diagonally.
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A box appears and stretches to follow the cursor. Pressing a mouse button
and dragging the cursor to create a box is called “drawthrough.”

3. Release the mouse button.

The area enclosed by the box you drew now fills the screen.

Next, create a box in which you want to fit the current window contents.

4. With the cursor inside the mux2 window, press and hold the Shift key.

5. Still pressing the Shift key, press and hold right and create a box in which
you want to fit the current window contents.

6. Release the mouse button.

The window zooms out. You see more of the design, but less detail.

Using Help
The Help button on forms and in windows displays information about the layout
editor.

■ To display a page of information about the command you are using, click
Help in the command form or options form.

■ To display the Virtuoso Layout Editor User Guide Table of Contents
from which you can navigate to the information you want to see, click Help
in a layout design window and choose Contents.

Another way to display Help is to use the F1 key at the top of your keyboard. F1
is the bindkey for Help.
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■ To display a page of information about a command, press F1 while your
cursor is in the design window and the command is running.

■ To see the Virtuoso Layout Editor User Guide Table of Contents,
press F1 while your cursor is in a layout design window.

Using the Help Button
In this section, you learn to use the Help system. You can use Help as you
perform any of the steps in this tutorial.

1. Click Help in the mux2 layout window.

The Help menu appears.

2. Choose Contents.

In a moment, the Virtuoso Layout Editor User Guide Table of
Contents appears.

3. Choose Help – Contents (at the top of the Help window) to read details
about using the OpenBook® on-line documentation library’s help.

A second window appears. You can click the topics in this window to find
out more about the Help system.

4. Click Close to close the FrameViewer – Help window.

5. In the Virtuoso Layout Editor User Guide Table of Contents, click any
blue text to read about that topic.

6. Click Close to close the Help window.
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Exiting the Cadence Software
You can exit the Cadence software at any time, it does not matter where you are
in your work. If you have unsaved work, the software prompts you to save your
work before you exit.

1. In the CIW, choose File – Exit to exit the software.

An Exit dialog box appears.

2. Click Yes in the dialog box to confirm that you want to exit.

The Cadence software stops this session and closes the CIW.

Note: If you leave any Cadence tools, windows, or forms open at the time
you exit, the software closes them also.

3. In the xterm window, press Return.

You see the exit message

[1] Done layoutPlus

Summary
In this chapter, you learned the fundamentals of using Cadence software and of
viewing designs. Specifically, you

■ Logged in and started the Cadence software

❑ Learned about the CIW

■ Browsed libraries with the Library Browser window
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❑ Displayed the libraries, cells, and views

❑ Opened a design in read-only mode

■ Changed the image for the design

❑ Fit the design to the window

❑ Returned to the previous image

❑ Zoomed in and out

❑ Scrolled

■ Learned to start commands different ways

❑ Used pull-down menus

❑ Used bindkeys

■ Learned how to display Help pages

■ Learned how to exit the Cadence software


